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LESSON 8: MAPPING THE WORLD TO
CHANGE THE WORLD

Teacher Pages

Grade levels: 6-12
Estimated time: 3—4 class periods

INTRODUCTION

In this lesson students use Google™ Earth to create maps of places with local, state,

national, or international significance. They pick an issue that is important to them and

then annotate the map as a way of communicating the importance of this issue to others.
In the fullest development of the lesson, they use the maps as persuasive tools in a
campaign to change their world for the better.

Examples of topics that can be mapped include (but are not limited to):

Local issues:

e & o o o o

Air pollution sources

Water pollution sources

Waste disposal facilities
Availability of recreation facilities
Availability of recycling centers
Urban sprawl

Urban blight

Flood zones

Real estate values

Family-owned versus corporate businesses
Travel time to emergency rooms
Traffic congestion

Unsafe road intersections
Availability of bicycle lanes

Bus routes versus student residences
Graffiti

Crime

Voting patterns by neighborhood

National or state issues:

Political affiliation by state or county
Energy production and use

Gas prices

Cost of living

Graduation rates
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e Teen pregnancy

e Water rights

e Resource allocation (mining, logging, etc.)
e Ranges of endangered species

International issues:
e Boundary disputes
e Resource allocation
e Political hot spots
e War/genocide
e Human rights violations
e Health issues
e Ranges of endangered species

OBJECTIVES

Students will:
o Learnto use Google Earth
e Select a local, state, national, or international issue to investigate
e Define the scope of the selected problem
e Research the selected issue
e Annotate Google Earth maps to organize their research findings
e Analyze their findings
e Propose solutions to the selected problem

e Present their findings and recommendations to the class, the public, and/or
relevant organizations

NATIONAL GEOGRAPHY STANDARDS

Standard 1. How to use maps and other geographic tools to acquire, process, and report
information from a spatial perspective

Standard 3. How to analyze the spatial organization of people, places, and environments
on Earth’s surface

Standard 18: How to apply geography to interpret the present and plan for the future

MATERIALS

e A computer with a projector or (ideally) several computers that students can
gather around

e An Internet connection so students can do research

e A library for research

e The “Drains to Ocean.kmz” file (included on the curriculum disc)
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PROCEDURE

First class session:

1.

Challenge students to use maps to change the world. Challenge them to think of a
problem—Ilocal, national, or international (you may prefer to narrow the
parameters)—suitable for exploration as a geographic question. Tell your students
that, by now, they should be both expert map readers able to extract information
from maps and skillful mapmakers able to express their ideas in maps. Tell them
that, in the project they are about to begin, you expect them to demonstrate their
mastery of “thinking like a geographer”—to ask geographic questions; to acquire,
organize, and analyze geographic information; and to answer geographic
questions.

Introduce the type of map they will be working with.

If you have Internet access, this activity can be based on the use of Google" Earth
(or another map program of your choice). If you do not have Internet access, this
exercise can be done through mapping by hand.

Assuming you have Internet access, if the Google™ Earth browser is not already
on your students’ computers, download a free copy from http://earth.google.com.
If possible, complete this download before beginning the lesson.

Once installed, tell students they will be looking at a map made by students who
researched the effects of storm-drain runoff in their local ecosystem. Let them
know that the students made this map for a presentation to be made first to their
classmates and then to local citizen groups as part of a campaign to build support
for remedying some of the problems in the storm-drain system.

Have students open the “Drains to Ocean.kmz” file (included on the curriculum
disc). This sample file includes photos and annotations to a map of Los Angeles
in which students examine the effects of storm-drain runoff on the local
ecosystem. The sample presentation will give the students a good idea of what it
might look like to annotate Google'" Earth with photos in order to illustrate an
issue. It is a model that they will emulate when they create and annotate their own
maps.

Fully discuss this map with students. Determine its purpose, note its strengths (ask
what features of the map help it accomplish its purpose) and critique its
weaknesses (ask: from your knowledge of map conventions, how could this map
be improved?).

To sample the mapping of an international issue, have them go to the Google "
Earth sidebar and either “Fly to” “Crisis in Darfur” or, looking under “Layers,”
check “Global Awareness” and then the subtopic “Crisis in Darfur.” This will
take them to a set of annotated maps created by the United States Holocaust
Memorial Museum. Clicking on the map’s icons opens windows with information
about the villages and people involved in this conflict. Students can scroll around
the map by clicking and dragging with the hand pointer.
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Note: Some of this content may be disturbing to students. Please preview the site
yourself and prepare students for what they are going to see by discussing the
Darfur situation before visiting the site. Before working in Google™ Earth you
may want to have students review the brief video presentation created by
Physicians for Human Rights (URL:
http://physiciansforhumanrights.org/sudan/darfur.html).

5. In the remaining class time, distribute Student Handout 1 and ask students to (1)
broaden their familiarity with similar maps and (2) acquaint themselves with the
features of Google " Earth. Students may continue the activity as homework if
most students have Internet access at home, or in a second class session if they do
not.

To familiarize themselves with other examples of annotated Google™ Earth maps,
students may examine the following Web sites (or teachers may prefer to make
their own suggestions). To open these files in Google™ Earth, students should first
save them to their computers. In Google  Earth’s menu bar, they’ll select File,
then Open. Then they’ll choose the file they would like to open.

e  World Population:
http:/services.google.com/earth/kmz/world_population_animation n.kmz

e World Energy Consumption:
http://services.google.com/earth/kmz/enerey consumption n.kmz

e World Oil Consumption:
http://services.google.com/earth/kmz/world oil consumption n.kmz

e World Population Density:

e Neighbors Against Irresponsible Logging:
http://services.google.com/earth/kmz/nail logeing n.kmz

* Global Historical Temperatures (note: long download):
http://services.google.com/earth/kmz/global_temperatures_n.kmz

Second class session:

1. Review the homework outlined in Student Handout 1. Your purpose is to have
students explain to each other what the features of Google =~ Earth are and how to
use them.

Ask students which features they explored. Employing a blackboard or
whiteboard, list all the features and functions of Google™ Earth that students have
gotten acquainted with (each student should have explored ten Google™ Earth
features). Taking the features one by one, for each feature they mention, ask:

e How many other students explored this feature?
e What does the feature do?

e Was this feature used in any of the annotated maps that you explored?
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e What are the advantages and disadvantages of using this feature?
e What technical problems did you run into when exploring this feature?

¢ Did anyone find solutions to these technical problems?

2. For homework, students with Internet access will work with Student Handout 2
to select a local, national, or international issue and Student Handout 3 to draft a
relevant Google™" Earth map (or draft a hand-drawn map for students without
home computers). In the final minutes of the class session, prepare students for
this homework by explaining your expectations and challenging them to think up
projects that can make a difference. Among your expectations:

e Students will choose an issue that can be addressed geographically
e Students will make the size of the project realistically doable

e Students will plan projects that have two stages:

o]

Gathering information and mapping it

© Communicating the information to make a difference

e Students will return to class with:

o

A draft of a map that demonstrates a geographical approach to the
problem

o

A written plan explaining how they intend to:
» Gather and map relevant information
o Communicate the information to make a difference

To accomplish the second goal of the homework assignment (designing a project
that is realistically doable), students will need to know the size of the team that
will be working on the project. For the purposes of the homework, tell students to
assume that they will be working in small groups and—depending on the
individual teacher’s preference—tell them what team size to expect.

It may be helpful to assign this homework over a weekend so motivated students
have ample time to do thoughtful work.

Third class session:

1. Ascertain which students are most excited about the topic they have chosen and
ask those students to summarize their findings for the class. Also ask two or three
students who fear that they may have chosen impractical topics to describe what
problems they ran into, and ask the class to brainstorm what changes might rescue
those topics to make them valid subjects for geographical investigation.

2. Either select a single topic for the whole class to investigate, or choose a number
of topics and divide students into teams to pursue each of the selected topics. The
goal of today’s class session is for the teams to (1) develop a practical plan for

wpsocalstudies.com
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conducting the necessary research, (2) plan the design of their map and its
features, and (3) predict how they could use their results to campaign for change.

If you choose to have the entire class work on a single mapping project, divide the
class into groups and assign each group different tasks. One group might do
Internet research. Another group might take pictures of local sites. Another group
might work on the html to create annotations for the map. Students should
consider what types of information they will need to find in order to create an
interesting and compelling map. Guide the class as it decides as a group how to
define its topic and how to proceed with the project.

Help students plan how to conduct research on the topic they’ve decided to map.
This might involve searching for information on the Internet, in the library, and in
their community. Their research should include the following aspects of the issue:

e Specific locations relevant to this issue

e Details about what’s happening in these locations

e Photos, if possible (students should be sure to cite their sources)
e Potential solutions to problems related to this issue

e Identifying the best audience to present their findings to

ASSESSMENT

To assess these student projects, consult the rubric labeled Teacher Handout 1.

EXTENSION IDEAS

Implement the plan. Use geographical thinking to study the world and change it.
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LESSON 8: MAPPING THE WORLD TO
CHANGE THE WORLD—GETTING
ACQUAINTED WITH GOOGLE EARTH

Student Handout 1

OBJECTIVE

Familiarize yourself with the program Google'" Earth. Learn how to read these maps and
use their features.

PROCEDURE

1. Ifthe Google™ Earth browser is not already on your computer, download a free
copy from http://earth.google.com.

Familiarize yourself with a variety of Google" Earth maps. Your teacher may
have suggested which maps you should explore, or you may begin with the maps
in the following list. To open these files in Google " Earth, first save them to your
computer. Then, in Google"" Earth, select File, then Open from the menu bar and
choose the file you would like to open.

e World Population:
hitp://services.coogle.com/earth/kmz/world population animation n.kmz

World Energy Consumption:
hitp://services.google.com/earth/kmz/energy_consumption_n.kmz

World Oil Consumption:

World Population Density:
http://services.google.com/earth/kmz/population density n.kmz

Neighbors Against Irresponsible Logging:
http://services.google.com/earth/kmz/nail logging n.kmz

Global Historical Temperatures (note: long download):
htip://services.coogle.com/earth/kimz/¢lobal temperatures n.kmz

3. Now get acquainted in a more general way with the features of Google™ Earth. In
the toolbar at the top, use the View menu to turn some of the features on and off.
In the same toolbar, select Help and check out the User Guide and Tutorials. As
you try out the features of Google'  Earth, use this handout’s graphic organizer to
keep a journal of what you discover. Familiarize yourself with at least five
GoogleTM Earth features, using the table to make notes about how they work. Be
ready to explain the features to your classmates.
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HOW IT WORKS
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LESSON 8: MAPPING THE WORLD TO
CHANGE THE WORLD

Student Handout 2

Important: Before you begin this assignment, find out from the teacher the size of the
team that will be working on your project.

OBJECTIVES

Select a local, national, or international issue that is important to you and that can be
studied as a geographical problem—a problem in a place.

e Choose an issue that can be addressed geographically
e Make the size of the project realistically doable
e Plan a project that has two stages:
°  Gathering information and mapping it

Communicating the information to make a difference
Return to your next class with:

© A draft of a map that demonstrates a geographical approach to the problem
A written plan explaining how you intend to:

e Gather and map relevant information

¢ Communicate the information to make a difference

o

o

The goal of this assignment is not to actually complete your project—that may come
later—but to show that you can make a realistic plan for accomplishing your project.

CREATING YOUR MAP

If you have Internet access at home, use Google " Earth (if you have not already done so,
download a free copy from http://earth.google.com) to create your map. If you do not
have Internet access, you can make a hand-drawn map.

WRITING YOUR PROJECT PLAN

See “Sample Map Project Plan” for an example of an acceptable project plan.
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SAMPLE MAP PROJECT PLAN

Choosing an issue that can be addressed geographically

We will study traffic and pedestrian safety near our school. We will try to make travel
near our school safer.

Making the size of the project realistically doable

We will research accidents that happened within a three-block radius of our school
over one school year.

Gathering information and mapping it

To find out how many traffic accidents happened close to our school, my first guess is
that we will need to study police reports.

We’ll study two types of accidents: car versus car and car versus pedestrian.

We’ll find all the accidents that happened in our study area from September to June
of the last school year. For each accident, we’ll find out where it happened and when.
On our map, we’ll show where the accidents happened, using a car symbol for car-
versus-car accidents and a pedestrian symbol for car-versus-pedestrian accidents. To
show when the accidents happened, we’ll make three maps: during travel time to
school, during school hours, and during travel time home from school. Nighttime
accidents seem irrelevant, so we’ll leave them out of our maps. If we have time, we
could also use a series of maps to track the accidents month by month. Then our
series of maps would tell us where the most dangerous places are, what time of day is
most dangerous, and what time of year is most dangerous.

Communicating the information to make a difference

After we study the dangers, we’ll make a presentation to our school’s Parent-Teacher
Association. If we find out that a certain intersection is most dangerous, we could ask
for a stop sign or a crosswalk. If we find out that a certain time of day or time of year
is most dangerous, we could ask for more crossing guards.
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LESSON 8: MAPPING THE WORLD TO
CHANGE THE WORLD—A FEW QUICK
TIPS FOR USING GOOGLE EARTH

Student Handout 3

Use Google " Earth to create your own customized map. If the Google " Earth browser is
not already on your computer, you can download a free copy from
http://earth.google.com.

Decide what issue you want to map and conduct preliminary research on the topic. After
conducting research and gathering information, you can create a map.

If you have access to YouTube (http://www.youtube.com) there are several helpful
tutorials that can be viewed. For example:

e “Marking Locations in Google " Earth”
(http://youtube.com/watch?v=FB1EseH7izs)

e “Navigating in Google" Earth”
(http://youtube.com/watch?v=vp9hX6008z4)

e “Searching in Google " Earth”
(http://voutube.com/watch?v=CaShi7L.G6Zs )

To create your map:

a) Zoom in on the location where you will place the annotation.

b) Choose Placemark from the Add menu. A dialog box opens which allows you to
name the placemark, select an icon (by clicking on the yellow pushpin), and
create a short description.

While the dialog box is open, select the exact location for the placemark by

dragging the icon across the map. Once you close the dialog box, the annotation is
fixed.

If you need to move the annotation after it is “fixed,” you can right-click (or
control-click on a Mac) on the annotation and choose Properties to open the
dialog box again. Then you can move the placemark or modify the annotation.

You can include links to Web sites in your annotations by using simple html. For
example, here is simple html for creating a link to more information on a Web
site:

See <a href="http://www.google.com">www.google.com</a> for a link to
Google.




You can use this as a template. Just copy and paste your text into your placemark,
and then change the URL and the message to create your own link.

To add a photo, select Add Photo from the Add menu. Name the annotation, and
use the Browse dialog to select an image file from your local computer, network,
or by creating a link to the Web.

For more information on using Google' Earth, creating annotations, and then sharing
your annotations with the world, visit http://earth.google.com/outreach/tutorials.htmi.
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LESSON 8: MAPPING THE WORLD TO
CHANGE THE WORLD—ASSESSMENT
RUBRIC

Teacher Handout 1

Criteria

Level 1

Level 2

Level 3

Level 4

Defines the
problem

Problem is not
clearly defined

Problem apparent
but unclear at
times

Clear expression
of problem

Problem is
expressed using rich
or persuasive detail

Evidence of
research

Little evidence of
research

Annotations show
some evidence of
research

Annotations show
clear evidence of
research

Annotations show
evidence of
considerable
research

Effective use of
Google"" Earth

Color and/or
symbols and
graphics unclear

Colors and/or
symbols and
graphics not
clearly supportive
of theme

Colors and/or
symbols and
graphics support
theme

The message or
purpose is obvious
to the audience
through the use of
color and symbols

Effective use of
text and/or
captions

Text minimally
displayed and
purpose unclear

Text clearly
displayed but
does not support
theme or message

Text supports the
purpose of the
map

Text or caption
delivers the message
with impact

Clear expression
of ideas when
presenting
findings/solutions

Communicates
information as
isolated pieces in
a random fashion

Communicates
important
information but
not a clear theme
or overall
structure

Clearly
communicates
main idea, theme,
or point of view

Powerfully
communicates main
idea, theme, or
viewpoint to
audience.

Overall impact
and creativity

Limited effort in
presentation is
shown; visuals
and texts do not
match each other
in quality; design
flaws in the
presentation

Visuals and text
are clear, though
their connection
may not be
obvious to the
audience; design
is efficient but
not innovative

Effort and
thoughtful
preparation
clearly shown;
elements of
innovation in the
presentation’s
design

The combination of
visuals and text
make for an eye-
catching design with
powerful impact
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